<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Welcome</td>
<td>1</td>
</tr>
<tr>
<td>Accessing F&amp;I Rate Track™/PowerMenu™/PowerTracking™</td>
<td>1</td>
</tr>
<tr>
<td>Through AccountConnect</td>
<td>1</td>
</tr>
<tr>
<td>Through Ristken</td>
<td>2</td>
</tr>
<tr>
<td>Session expiration</td>
<td>2</td>
</tr>
<tr>
<td>Using F&amp;I Rate Track™ within PowerMenu™</td>
<td>3</td>
</tr>
<tr>
<td>The setup process</td>
<td>4</td>
</tr>
<tr>
<td>Settings tab</td>
<td>4</td>
</tr>
<tr>
<td>Profit Settings tab</td>
<td>4</td>
</tr>
<tr>
<td>Additional Dealer Markup tab</td>
<td>6</td>
</tr>
<tr>
<td>Display Preferences tab</td>
<td>7</td>
</tr>
<tr>
<td>Profit</td>
<td>7</td>
</tr>
<tr>
<td>VSC Coverage</td>
<td>8</td>
</tr>
<tr>
<td>VSC Deductibles</td>
<td>8</td>
</tr>
<tr>
<td>Maintenance Service Type</td>
<td>9</td>
</tr>
<tr>
<td>Maintenance Service Interval</td>
<td>9</td>
</tr>
<tr>
<td>Tire &amp; Wheel Coverage</td>
<td>9</td>
</tr>
<tr>
<td>Other Lienholder Setup</td>
<td>9</td>
</tr>
<tr>
<td>Limited Warranty tab</td>
<td>10</td>
</tr>
<tr>
<td>Terms Offered tab</td>
<td>11</td>
</tr>
<tr>
<td>Terms Display Order</td>
<td>12</td>
</tr>
<tr>
<td>Security Guard Terms/Benefits</td>
<td>12</td>
</tr>
<tr>
<td>Check all VSC Terms button</td>
<td>12</td>
</tr>
<tr>
<td>VSC Option Setup</td>
<td>12</td>
</tr>
<tr>
<td>The quoting process</td>
<td>13</td>
</tr>
<tr>
<td>Quote tab</td>
<td>13</td>
</tr>
<tr>
<td>New Quote tab</td>
<td>13</td>
</tr>
<tr>
<td>Saved Quotes tab</td>
<td>14</td>
</tr>
<tr>
<td>Archiving a quote</td>
<td>15</td>
</tr>
<tr>
<td>Viewing a quote</td>
<td>16</td>
</tr>
<tr>
<td>Printing a quote</td>
<td>16</td>
</tr>
<tr>
<td>Modifying a quote</td>
<td>17</td>
</tr>
<tr>
<td>Search Quotes tab</td>
<td>18</td>
</tr>
<tr>
<td>The contracting process</td>
<td>19</td>
</tr>
<tr>
<td>Selecting quotes to contract</td>
<td>19</td>
</tr>
<tr>
<td>SPP as lienholder</td>
<td>20</td>
</tr>
<tr>
<td>Completing the eContract</td>
<td>21</td>
</tr>
<tr>
<td>Current Contracts tab</td>
<td>22</td>
</tr>
<tr>
<td>View an eContract</td>
<td>22</td>
</tr>
<tr>
<td>Archiving an eContract</td>
<td>22</td>
</tr>
<tr>
<td>Search Contracts tab</td>
<td>23</td>
</tr>
<tr>
<td>Modifying Contracts</td>
<td>24</td>
</tr>
<tr>
<td>The remitting process</td>
<td>25</td>
</tr>
<tr>
<td>Current Contracts tab &amp; Search Contracts tab</td>
<td>25</td>
</tr>
<tr>
<td>Finalizing an eContract</td>
<td>25</td>
</tr>
<tr>
<td>Saved Quotes tab &amp; Search Quotes tab</td>
<td>25</td>
</tr>
<tr>
<td>Finalizing a quote</td>
<td>25</td>
</tr>
<tr>
<td>Remit Register tab</td>
<td>26</td>
</tr>
<tr>
<td>Open Register tab</td>
<td>26</td>
</tr>
</tbody>
</table>
Editing the open register ................................................................................................................... 27
Finalizing and closing the open register ............................................................................................. 28
Open SPP register tab .......................................................................................................................... 29
   Editing the open SPP register ........................................................................................................... 29
   Finalizing and closing the open SPP register .................................................................................... 30
Search registers tab ............................................................................................................................. 30
   Additional Dealer Markup Report tab .............................................................................................. 31
Navigation hints ................................................................................................................................. 32
   To maximize a window ...................................................................................................................... 32
   To close a window .............................................................................................................................. 32
   To log out of the application ............................................................................................................ 32
   To return to the application after a timed-out session ................................................................... 32
   For more information about pop-up blocker ................................................................................... 32
Zurich Customer Support: 1-800-494-3317 ....................................................................................... 32
Welcome

F&I Rate Track™ is a web-based F&I quoting application created for Zurich. Some of the many benefits of F&I Rate Track™ include:

- Population of vehicle information by entry of the VIN.
- Integration with PowerMenu™, VSC, Maintenance, Tire & Wheel, Select Comp Plus, Universal Security Guard® and GAP quotes saved in PowerMenu™ also save in F&I Rate Track™.
- Creation of electronic contracts and electronic remittance of the electronic contracts.

Accessing F&I Rate Track™/ PowerMenu™/ PowerTracking™

Through AccountConnect

AccountConnect is the name of the Zurich customer website.

Enter www.uug.com in the address field of the internet browser. Save as a favorite.
- Log into AccountConnect.
- Click the F&I heading.
- Click the desired application, i.e. F&I Rate Track™, PowerMenu™ or PowerTracking™. The application will open in a new window.

Tip: If the application does not open in a new window, make sure the pop-up blocker is disabled for the AccountConnect page.

Note: See Navigation Hints section for more information on how to navigate in F&I Rate Track™.

Note: If you are using Internet Explorer 8 and higher, make sure the compatibility setting is set to Internet Explorer 7.
Through Ristken

2. Log into Ristken, using Zurich user id and password.
3. Select the dealership.
4. Click the desired application, i.e. F&I Rate Track™, PowerMenu™ or PowerTracking™.

Note: New users must complete the sign up process via Zurich customer portal before logging in via Ristken.

Session expiration

After 40 minutes of no activity, the F&I Rate Track™ and PowerMenu™ sessions will expire. This screen will display.

- Click the word ‘HERE’ link to return to the application.

Note: If you close the window, you must return to www.uug.com or apps.ristken.com and complete the login process.
Using F&I Rate Track℠ within PowerMenu™

PowerMenu™ users can use F&I Rate Track℠ to quote and save VSC, Maintenance, Tire & Wheel, Select Comp Plus, Universal Security Guard® and GAP products within the PowerMenu™ application.

- Click PowerMenu™ from AccountConnect.
- Enter customer last and first name (required).
- Click vehicle link and enter vehicle’s mileage and VIN. Close the small window.
- Click the Rate All link in Product Option 1 or details link of the product. F&I Rate Track℠ will open in new window. Complete rating the product. Click Save. The window will close and return to PowerMenu™.

**Note:** The F&I Rate Track℠ quotes saved in via PowerMenu™ will appear in the stand-alone F&I Rate Track℠ also.

**Note:** Limited warranty only product (‘No Upgrade’) is available when rating in F&I Rate Track via PowerMenu, but it will display as no charge to the customer.
The setup process

Before using the application, it is important to complete setting up the application.

Settings tab

Establish profit, additional dealer markup, display preferences, limited warranty terms and VSC terms via the Settings tab. These settings will determine the view and behavior of the quote screen for all dealership users.

Note: Depending on your login privileges, you may not have access to this tab.

Profit Settings tab
There are three ways to set profit:

**Fixed**: Dollar value mark-up

- Select Fixed.
- Enter a dollar amount.
- Enter ‘Not to exceed’ remit percentage cap, if applicable. (optional)
- Click Save.

**Variable**: Percentage mark-up

- Select Variable.
- Enter a percentage.
- Enter minimum (floor) and maximum (ceiling) dollar amounts, if applicable. (optional)
- Click Save.

**Fixed Retail**: The same retail price will display for all terms regardless of underlying cost

- Select Fixed Retail.
- Enter a dollar amount as the retail price.
- Click Save.

**Note**: Dealerships in Florida will be able to change Maintenance and GAP profit settings only. VSC and Tire & Wheel profit is regulated by the state. Dealerships in Pennsylvania will default to the Pennsylvania Lending Rule profit calculation and applies to VSC, Tire & Wheel and GAP products.
Additional Dealer Markup tab

<table>
<thead>
<tr>
<th>VSC Additional Dealer Markup</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>VSC New</td>
<td>$100</td>
</tr>
<tr>
<td>VSC Used</td>
<td>$100</td>
</tr>
<tr>
<td>Select *</td>
<td>$100</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>LW Additional Dealer Markup</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic Short Term</td>
<td>$50</td>
</tr>
<tr>
<td>Basic Long Term</td>
<td>$50</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>MAINTENANCE Additional Dealer Markup</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintenance</td>
<td>$25</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>TIRE &amp; WHEEL Additional Dealer Markup</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Tire &amp; Wheel</td>
<td>$25</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>GAP Additional Dealer Markup</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>GAP</td>
<td>$25</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SECURITY GUARD Additional Dealer Markup</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Security Guard</td>
<td>$25</td>
</tr>
</tbody>
</table>

* Setting applies to Rental Plus, Select Comprehensive, Select Comp Plus, and Manufacturer Certified Upgrade plans.

Additional dealer markup amount may be set by product. Additional dealer markup is **not** remitted to Zurich.

- Enter additional dealer markup amount.
- Click Save.

**Note:** A separate additional dealer markup report will be generated to assist with tracking these values. See Remit Register section for more information.
Display Preferences tab

Display preferences settings minimize keystrokes during the quote process.

**Profit**

*Display Profit and Remit* - determines the display of profit and remit field/columns on all screens, including Quote tabs, Contract tabs and Modify screens.
Select display profit and remit option (‘Do Not Display’, ‘Always Display’, ‘Display on Right-Click’).

Allow Retail Price to be modified - enables user to change the price quoted via the quote screen.

- Select retail price modification option (‘Yes’ or ‘No’).

Note: When ‘Display on Right-Click’ option is select, right-click in the Price field in the Selected Quote box to see the remit.

VSC Coverage

Display Order - determines the order of VSC coverages displayed on the quote screen.

- Select a coverage.
- Click the green (up) or orange (down) arrows to change the order of the list.

Show On New Plans - determines the coverage(s) available for new plans.

- Uncheck any coverage that the dealership does not want to sell for new plans. All coverages are checked by default.

Show On Used Plans - determines the coverage(s) available for used plans.

- Uncheck any coverage that the dealership does not want to sell for used plans. All coverages are checked by default.

Default - determines the selection that pre-populates the field on the quote screen.

- Select a coverage.

VSC Deductibles

Display Order - determines the order of VSC deductibles displayed on the quote screen.

- Select a deductible.
- Click the green (up) or orange (down) arrows to change the order of the list.

Show On New Plans - determines the deductible(s) available for new plans.

- Uncheck any deductible that the dealership does not want to sell for new plans. All deductibles are checked by default.

Show On Used Plans - determines the deductible(s) available for used plans.

- Uncheck any deductible that the dealership does not want to sell for used plans. All deductibles are checked by default.

Default - determines the selection that pre-populates the field on the quote screen.

- Select a deductible.
Note: If the default coverage or deductible is not available for the product, the user must make a manual selection from the drop-down list on the quote screen.

Maintenance Service Type
Default - determines the service type that pre-populates the field on the quote screen for maintenance plans.

- Select a service type.
- Click Save.

Maintenance Service Interval
Default - determines the service interval that pre-populates the field on the quote screen for maintenance plans.

- Select a service interval.
- Click Save.

Tire & Wheel Coverage
Default - determines the coverage that pre-populates the field on the quote screen for tire & wheel plans.

- Select a coverage.
- Click Save.

Other Lienholder Setup
Add Lienholder – allows additional lienholder to be added for eContract purposes. User can select the lienholder during the quote or eContract process.

- Enter a lienholder name.
- Click Add.

Available Lienholders – displays the lienholders added.

- Click the green (up) or orange (down) arrows to change the order of the list.
- To remove a lienholder, select the lienholder and click Remove.

Note: FMC, GMAC and TOYOTA are defaults that may not be modified.
Limited Warranty tab

If the dealership is enrolled in Certified Protection® (Select Warranty® in California and New York), warranty terms will display on the limited warranty tab.

- Click the checkbox of the applicable limited warranty terms.
- Select the applicable deductible.
- Click Save.

**Note:** If the dealership is not enrolled, a message will display on the screen ‘No limited warranty products available.’
The terms displayed on the quote screen may be customized.
Terms Display Order
- Select the order terms will display (‘Ascending’ or ‘Descending’).

Security Guard Terms/Benefits
- Check the specific Universal Security Guard® term/benefit sold at the dealership.

Note: This section will not appear if dealership does not sell Universal Security Guard® product.

Check all VSC Terms button
- Click the button to check all VSC term boxes.
- Uncheck any specific term that is not to display on the quote screen.

VSC Option Setup
- Click the applicable option(s) (‘Snowplow’ and/or ‘Commercial’) to display on the quote screen.
- Click Save.

Tip: For more details regarding snowplow or commercial options, click the icon next to the option.

Note: The screenshot may vary from the actual screen due to program changes.
The quoting process

Quote tab

A main component of F&I Rate Track™ is the quote process.

New Quote tab

- Enter the vehicle information. (PowerMenu passes this information.)
- Select the product and complete the product fields.
- Click Display Terms.
- Select a term. The selected term and price will appear in Selected Quote area. The product quote will also be listed in the Quotes to Save area.
- To quote another product for the same customer, select another product and complete the product fields. Repeat the previous steps.
- Enter the customer name (last and first names are required fields). If vehicle is business owned, select the Business Owned radio button and enter the company name and primary driver’s name (required fields).
- Complete the address and phone number fields.
- Select the lienholder and add the vehicle purchase price.
- For dealerships enrolled in the Service Payment Program (SPP), you may indicate the quote is SPP financed by checking the SPP box.
- Click the appropriate function button.
  - Save Quote(s) – saves the quote(s) in the Quotes to Save area, presents user with blank new quote screen.
  - Save & eContract – saves the quote(s) in the Quotes to Save area, and proceeds to eContract.
  - Save & Print – saves the quote(s), presents user with printed quote (in PDF format).
  - Print – Presents user with printed quote (in PDF format), but does not save the quote.
  - New Quote – Does not save the quote, presents user with blank new quote screen.

**Tip:** All the customer details entered will be used to populate the electronic contracts during the eContracting process.

**Note:** Only lienholders added in Settings are listed in lienholder field. The field should be left blank if the lienholder needed is not listed. It can be entered directly on the eContract form. The vehicle purchase price may be changed directly on the eContract form.

**Saved Quotes tab**

After a quote is saved, you may view, print, or modify the quote. You can also create an eContract for the quote.

- Icon indicates quote has a VIN and is ready for eContracting process.
- Icon indicates eContract activity for the quote. See eContract activity for the quote under Current Contracts tab.
- Sort the list by clicking the column heading. By default, the list is sorted by customer last name, first name.

**Tip:** To see the full VIN and vehicle’s year, make and model, place the mouse arrow over the truncated VIN.
Note: Product and coverage codes for VSC program are as follows:

<table>
<thead>
<tr>
<th>Product</th>
<th>Prod</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vehicle Service Contract</td>
<td>VSC</td>
</tr>
<tr>
<td>Limited warranty</td>
<td>LW</td>
</tr>
<tr>
<td>Maintenance</td>
<td>MNT</td>
</tr>
<tr>
<td>Tire &amp; Wheel</td>
<td>TW</td>
</tr>
<tr>
<td>Select Comp Plus</td>
<td>SCP</td>
</tr>
<tr>
<td>GAP</td>
<td>GAP</td>
</tr>
<tr>
<td>Security Guard</td>
<td>SG</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Cov</th>
<th>Coverage</th>
<th>Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>25, 35, 50, 75, 100</td>
<td>Class 25, 35, 50, 75, 100</td>
<td>Maintenance</td>
</tr>
<tr>
<td>CMP</td>
<td>Comprehensive</td>
<td>VSC</td>
</tr>
<tr>
<td>LW</td>
<td>No upgrade</td>
<td>Limited warranty</td>
</tr>
<tr>
<td>LXY</td>
<td>Luxury</td>
<td>Tire &amp; Wheel</td>
</tr>
<tr>
<td>PRF</td>
<td>Preferred</td>
<td>VSC</td>
</tr>
<tr>
<td>PRM</td>
<td>Premium</td>
<td>Tire &amp; Wheel</td>
</tr>
<tr>
<td>PWT</td>
<td>Powertrain</td>
<td>VSC</td>
</tr>
<tr>
<td>RNT</td>
<td>Rental</td>
<td>VSC</td>
</tr>
<tr>
<td>SCP</td>
<td>Select Comp Plus</td>
<td>Select Comp Plus</td>
</tr>
<tr>
<td>SEL</td>
<td>Select Comprehensive</td>
<td>VSC</td>
</tr>
<tr>
<td>STD</td>
<td>Standard</td>
<td>VSC, Tire &amp; Wheel</td>
</tr>
</tbody>
</table>

Archiving a quote

A saved quote can be manually removed from the Saved Quotes tab by archiving. Use the archive function for quotes that do not result in actual contracts. Quotes that were saved in the past 45 days and have no other actions will be automatically archived.

- Select the Archive button for the quote.
- Click Save.

Note: Use Search Quotes tab to locate quotes archived and finalized quotes. See Remit Register section on finalize quote function.
Viewing a quote

- From Saved Quotes or Search Quotes tab, click the customer name to view the quote.
- View Quote window will open.

Note: See eContracting process for Create Contract function.

Printing a quote

- From View Quote window, click Print.
- A print preview window will open.
- Click the printer icon to print. To return to the previous view, click File > Close.
Modifying a quote

- From View Quote window, click Modify.
- Modify Quote window will open and all the products quoted together will display in Quotes to Save area.
- Make the changes to the product quotes or customer details.
- Click the appropriate function button.
  - Update – save changes to the existing quote and close Modify Quote window.
  - Update & eContract – save changes to the existing quotes and proceeds to eContract.
  - Save as New – save changes to a new quote.
  - Save as New & eContract – save changes to new quotes and proceeds to eContract. Previously created contracts will be archived.
  - Save & Print – save changes to new quotes and presents user with printed quote (in PDF format).
  - Print – Presents user with printed quote (in PDF format), but does not save the quote.
  - Close Window – exit without saving changes.

Note: You can only save the quote as a new quote, if the date of sale or vehicle information is modified.
## Search Quotes tab

![Search Quotes Tab](image)

- Enter search criteria (only a date range is required).
- Click Search.

**Tip:** The date range is defaulted to seven days in the past. To change a date, click the calendar icon and click the date. You may use the arrow(s) to change the month or year.

**Note:** Quotes displayed have a status of saved (S), finalized (F) or archived (A). Saved quotes that are not finalized will be archived after 45 days from the quote date.
The contracting process

After a quote with VIN is saved, it is eligible for the contracting process. Once the contracting process begins, the associated quote(s) cannot be modified and will have the same status as the contract.

Selecting quotes to contract

- From Saved Quotes or Search Quotes tab, click the icon next to the quote.
- Or click Create Contract button from View Quote window.

The Contract Forms window will open and list all the eligible quotes for the customer, based on VIN, odometer and date of sale.
• Select the product quotes that you want to contract.
• Select the lienholder. If lienholder is not ‘FMC’, ‘GMAC’ or ‘TOYOTA’, select ‘ALL OTHER LIENHOLDERS’.
  Lienholder field may not appear if the product form is not lienholder specific. If additional lienholders
  had been set up, user can select them under ‘ALL OTHER LIENHOLDERS’.
• Click Get Forms. Forms for the selected product quotes will be listed with ‘Create Contract’ link.
• Click on the link to view the eContract. The eContract will open in new window.
• If limited warranty is part of the associated quotes, the appropriate limited warranty provisions will be
  listed and available for printing.
• Click Close Window when you are done with all the eContracts.

Tip: You may return to an eContract via Current Contracts or Search Contracts tab.

Note: As forms may be lienholder specific, it is important that the correct lienholder is selected. See also SPP
  as lienholder section.

Note: In certain instances, the products will be grouped together if the products use the same form.

SPP as lienholder
If the customer opted to finance VSC/Maintenance/Tire & Wheel purchase via SPP, while the purchase of
other F&I products are financed elsewhere, follow the steps below to ensure the correct form is used.

• When selecting quotes to contract in the Contract Forms window, select the SPP financed products only.
  The quote list will show all the quotes, including those that are not marked as SPP.
• Complete the eContracting process.
• Then return to Saved Quotes tab and start the eContracting process for non-SPP products.
Completing the eContract

The PDF contract form will be populated based on the quote, including vehicle, customer and product information.

- Complete the form by populating the rest of the required fields.
- Click the appropriate function button.
  - Print Official – saves the completed eContract and prints an official (active) copy, without ‘Draft’ watermark; contract status will be ‘Official’.
  - Print Draft – Prints a draft copy with ‘Draft’ watermark, does NOT save any changes.
  - Save – saves the changes to the eContract form, returns user to Contract Forms window; contract status will be ‘Saved’.
  - Discard – Discards the changes and closes the eContract form.
  - Re-print – Prints another official copy of the eContract.
- Close the PDF window and return to the Contract Forms window for the next eContract.

**Note:** All required fields on PDF contract form must be completed before Print Official function can be used.

**Note:** Do not use the printer icon within the PDF window. Use the appropriate function button on the form instead.
All eContracts that have the status of ‘Official’ or ‘Saved’ will be listed under Current Contracts tab. Only eContracts with status of ‘Official’ can be finalized.

View an eContract

- Click the status link to view the eContract.

Archiving an eContract

An eContract can be manually removed from the Current Contracts tab by archiving. Use the archive function for eContracts that do not result in actual sale.

- Select the Archive button for the eContract.
- Click Save.

Note: eContracts with status of ‘Official’ will remain on the Current Contracts tab until manually archived or finalized. Saved eContracts that are not finalized will be automatically archived after 45 days from the last modified date.
Search Contracts tab

- Enter search criteria (only a date range is required).
- Click Search.

Tip: The date range is defaulted to one month in the past. To change a date, click the calendar icon and click the date. You may use the arrow(s) to change the month or year.

Note: eContracts displayed have a status of saved, official, finalized, submitted or archived. Saved eContracts that are not finalized will be archived after 45 days from the last modified date.
Modifying Contracts

F&I Rate Track provide the ability modify an existing contract or add more products to a customer with existing contract.

- Go to Current Contracts tab or look up the customer name on Search Contracts tab.
- Click the Modify Contract icon. Modify Contracts window will open.
- Check Modify Customer and/or Lienholder information box to modify all contracts listed.
- Or check only the contract you wish to modify.
- To add another product for the customer without modifying existing contracts, check the specific Add product box.
- Click Continue. Modify Quote window will open.
- Make changes to product quotes, customer information and/or lienholder.
- Click Save as New & eContract. Contract Forms window will open and list the forms based on products and lienholder information. Complete eContract process as normal.

Note: The current contracts will be archived once you click Save as New & eContract. New contracts will be created based on the modified new quotes, customer information and lienholder. Remember to retrieve the previous contracts from the customer.
The remitting process

After a quote is saved, or a contract is official, it can be marked for the remit register through a number of screens. Quotes or eContracts marked for the remit register will have the status of finalized. The finalized quote or eContract will remain on the remit register until it is removed or until the remit register is finalized and closed.

Note: This section is only applicable to dealership personnel who complete the remittance process and paperwork.

Current Contracts tab & Search Contracts tab

- Access the Current Contracts tab or Search Contracts tab.
- Select the Finalize radio button beside the customer name to finalize.
- Click Save Changes.

Note: Only contracts that have 'Official' status may be finalized.

Saved Quotes tab & Search Quotes tab

- Access the Saved Quotes tab or Search Quotes tab.
- Select the Finalize radio button beside the quote(s) to finalize.
- Click Save Changes.
Tip: A quote can also be finalized on the View Quote window.

Note: Only quotes that have a VIN may be finalized. See **Modifying a quote** section to add a VIN to a saved quote.

Note: Dealership personnel with F&I manager role can finalize their own quotes or contracts, but will not be able to view the Remit Register tab.

## Remit Register tab

![Remit Register tab screenshot]

A remit register must be generated and attached to the company copy of applications that do not have eContracts and mailed by the 10th of the following month.

## Open Register tab

![Open Register tab screenshot]

Once the saved quote or official eContract is marked finalized, it will appear in the open register of the product.

- Select the product of the remit register.
- Finalized eContracts will be listed in the ‘New Business – Finalized eContracts’ section by customer name and grouped by the contract form.
- Finalized quotes will be listed in the ‘New Business – Finalized Quotes’ section by customer name.
- For GAP remit register: Enter the agreement number for finalized quotes.
- For Security Guard remit register: Enter the registration number for finalized quotes.

Note: The remit amount on the register is the amount to be remitted to Zurich and does not contain additional dealer markup.
Editing the open register

The open register may be modified prior to being finalized.

Add a cancellation

- Click Add a Cancellation.
- Enter the customer name (required), product, VIN, contract number, cancellation amount (required).
- Click Save Changes.

Add an adjustment

- Click Add an Adjustment.
- Enter the reason for the adjustment, product and amount to add to the register.
- Click Save Changes.

Note: Once you save the cancellation or adjustment, you will not be able to make any changes to the cancellation or adjustment entry except to remove the whole entry.

Remove a finalized contract, quote, cancellation or adjustment

- Check the checkbox in the far right column titled remove for the finalized contract, quote, cancellation or adjustment to remove.
- Click Save Changes.

Tip: You may make all the edits and click Save Changes at the end. To disregard any unsaved changes made, click Cancel.
Finalizing and closing the open register

Once the open register is complete, it must be finalized and closed.

- Enter the check number, if appropriate.
- Click Finalize and Close.
- A new window will open and display the finalized and closed remit register.
- Click Print.
- The print preview window will open.
- Click the printer icon to print. To return to the previous view, click File > Close.

**Note:** Totals section will only display the products available at the dealership.
Open SPP register tab

If the finalized contract or quote is also marked SPP financed, it will appear on the open SPP register.

Editing the open SPP register
The open SPP register must be edited prior to finalizing it.

Add SPP fee and amount financed

- Enter the SPP Fee.
- Enter the amount financed.
- Click Save Changes.

Note: The amount financed must be equal to or greater than the sum of the remit plus SPP fee.
Finalizing and closing the open SPP register
Once the open SPP register is complete, it must be finalized and closed.

- Click Finalize and Close.
- A new window will open and display the finalized and closed remit register.
- Click Print.
- The print preview window will open.
- Click the printer icon to print. To return to the previous view, click File > Close.

Search registers tab

All registers may be retrieved via the search register screen.

- Enter search criteria.
- Click Search.
- Within the search results, click the appropriate remittance period.
- A new window will open and display the selected remit register.
- Click Print (optional).

Note: A copy of the Additional Dealer Markup Report is associated with each finalized register. Click the icon in the far right column to view the additional dealer markup report of the appropriate remit register period.
### Additional Dealer Markup Report tab

<table>
<thead>
<tr>
<th>Customer Name</th>
<th>VIN</th>
<th>Date of Sale</th>
<th>Prod</th>
<th>Cov</th>
<th>Term</th>
<th>Sale Assoc</th>
<th>Additional Dealer Markup</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edward, Gary</td>
<td>7P150990</td>
<td>10/14/09</td>
<td>LW</td>
<td>LW</td>
<td>72/250,000</td>
<td>NM, J</td>
<td>$ 69.00</td>
</tr>
<tr>
<td>Scott, Jason</td>
<td>78012522</td>
<td>10/14/09</td>
<td>LW</td>
<td>RGF</td>
<td>72/100,000</td>
<td>NM, J</td>
<td>$ 225.00</td>
</tr>
<tr>
<td>Sara, Brian</td>
<td>02304681</td>
<td>10/14/09</td>
<td>VSC</td>
<td>CHD</td>
<td>48/50,000</td>
<td>NM, J</td>
<td>$ 225.00</td>
</tr>
<tr>
<td></td>
<td>MEINT</td>
<td>12/01/09</td>
<td></td>
<td></td>
<td></td>
<td>NM, J</td>
<td>$ 10.00</td>
</tr>
</tbody>
</table>

**Total:** $530.00

The additional dealer markup amount is recorded for each finalized quote or finalized eContract. The additional dealer markup report displays the additional dealer markup amount for the finalized quotes and eContracts in the open register or open SPP register.

- Click Print.

**Note:** The Additional Dealer Markup Report tab is automatically refreshed when the open remit register is finalized and closed. A copy of the Additional Dealer Markup Report is associated with each finalized register.
Navigation hints

- Use the mouse or **tab** key to navigate the fields on new quote screen.
- Do not use the Enter key. F&I Rate Track™ will attempt to save a quote before you are ready to save it.
- Be patient while the application processes the quote or contract. The screen may take several seconds to refresh.
- Do not use the buttons in the menu toolbar, such as back, forward, stop and refresh while a screen is refreshing. It will interfere with the processing of the quote or contract.

Internet Explorer 8
If you are using Internet Explorer 8, click the IE toolbar Tools> Compatibility View

To maximize a window
- Click the square box at the top right corner of the window.

To close a window
- Click the X at the top right corner of the window.
- Click the close window button on the screen, if available.

To log out of the application
- Click the logout link.

To return to the application after a timed-out session
- Re-login to AccountConnect.
- Click the F&I Rate Track™ button on the F&I page.

For more information about pop-up blocker

Zurich Customer Support: 1-800-494-3317